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Your Search Is Over!

QuikCalc is the ultimate mortgage and loan amortization tool
for home and business users!

Know Exactly What Is Owed
With QuikCalc Premium Edition
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Premium
Edition
$139.95

Available for Immediate
Download and on CD-
ROM

QuikCalc Amortization comes in four editions to meet your needs and is in use by
thousands of professionals, individuals and government departments around the
world. QuikCalc is a complete mortgage and loan management tool for those
who need to track mortgages and loans as well as generate amortization
schedules for planning purposes. (If you are a business needing to track clients and

their loans, check out the Office Edition). [ETRY NOow |[JBUY NOW
® Quickly and easily create simple and complex schedules Need More Features? Try...
® Track any number of loans simultaneously including early, late, missed and extra payments, varying QuikCalc Office Edition $299.95
interest rates and much more.

® Solve for payment amount, loan amount, interest rate or loan period then instantly create a schedule Need Less Features? Try...
® Create payment grids within seconds QuikCalc Plus! Edition $69.95
e Perform most basic financial time value of money calculations with the bonus calculators QuikCalc Home Edition $39.95

® Print Payment Coupons to help those who borrow money from you pay on time
Available Editions:
Office Edition $299.95
Premium Edition $139.95
Click hare to Plus! Edition $69.95
’ Home Edition $39.95
Try Now!
Corporate Logo Plug-in $59.95

Fully functional demo

Other Products:
Click Here to Collapse All Debt Elimination & Consolidation Software
DebtCalc Three Editions starting at $39.95
Ql‘"kcalc Beneflts Click Here to Collapse Income Needs Analyzer and Net Worth Calculator

Retire! Four Editions starting at $39.95

> Try the demo now!

Vehicle Loan vs. Lease Software
. . . . VehiCalc Two Editions Starting at $39.95
QuikCalc is a powerful, user friendly tool that allows you to create flexible g at $

amortization schedules that go far beyond the static tables available from most other ) :
FirstResponse Email Reply Management System

programs. As well, track the most complex of loans to the penny with the Loan FirstResponse $99.95
Manager!

Need non-standard schedules? The Amortization Schedules Plus! feature included in the QuikCalc Plus!, 'Da._V
Premium and Office Editions allows you to add any number of extra payments to a schedule, skip payments plus Uncond ]onaf
add weekly, monthly or yearly lump sums starting in any year. No longer are you restricted to static tables that

generate a schedule that offers no flexibility. Money-Back
View Screen Shot Guarantee!

QuikCalc is quick and easy to learn and is already
in use by thousands of individuals and
professionals across the United States and the
world. We've been in business for over 15 years
Like to play "what if" with your mortgage or loan? Amortization Schedules Plus! is the ultimate tool for this.  and offer a 60 day money back guarantee on all
You can change any parameter affecting your loan including payment amounts and frequencies, interest rates of our software so there is no risk to you!
and compounding methods as well as payment types including interest only loans.

Want to save money? With QuikCalc you can see immediately the impact that extra payments or an increased
regular payment can have to the bottom line including infrequent or regularly scheduled lump sums.

Need to generate schedules for interest only or graduated loans? No problem, QuikCalc has eight different
payment types including normal, interest only (static and adjusting), increasing (by fixed amount or percentage)
and no payment.

Track loans to the penny. You can track missed, late, early, extra and lump sum payments with the Loan
Manager. This way you will always know exactly what is owed.
View Screen Shot #1 View Screen Shot #2

Have you lent money and they sometimes pay late? If a customer is late in paying, QuikCalc allows you to
track the extra interest due and assess late fees and penalties. For U.S. Rule (Simple Interest) loans, QuikCalc
will also track the interest escrow for you.

Detailed and summary reports are at your fingertips. Generate reports on demand that include annual
summaries based upon any corporate year end. If there is a dispute, you have the numbers to back up what you
say is owed. You choose the level of detail and the dates between which the report will be generated.

Track the most complex of loans. QuikCalc not only can track standard loans, it can also track the most
complex of loans including ARM (Adjustable Rate Mortgages) and loans where the terms change including rates
and payment types. An example could be a loan that begins as an Interest Only loan then switches after five
years to a regular payment loan.

Do you need multiple Day Count Conventions? Most amortization programs only generate schedules for
30/360. We include 14 different Day Count Conventions including Actual/Actual that cover almost every type of



loan in existence.

Have you borrowed or lent money? If you have, and you've had problems agreeing on what is owed,
payments are occasionally late or early, or extra payments are sometimes made, you can know exactly what is
owed so that you are informed and in control. Generate your own reports to compare with as much detail as you
need.

Do your payments include more than just principal and interest? If so, QuikCalc can track this for you too
including tax and insurance escrow accounts. You can even add your own things to track and specify how
frequently they occur and what the amounts are (even as a percentage of many different variables).

Want to create what if scenarios? See the effect of:

Adding any number of extra payments

Putting an annual, monthly or weekly lump-sum on the loan starting in any year
Skipping/missing payments

Late or early payments

Late penalties and fees

Insurance, Tax and Interest Escrow

Different payment types including interest only

Various Day Count Conventions including 30/360 and Actual/Actual

Different compounding methods including U.S. Rule (Simple Interest) and Canadian mortgages
Changing any payment amount

Switching to accelerated payments

Renegotiating interest rates

And much more!

View Screen Shot

Click here to

Try Now!

Fully functional demo

< Back to Benefits

QuikCalc Features Click Here to Collapse
> Try the demo now!

QuikCalc includes all of the features you will need to track the most complex loans to
the penny. Need even more power? Check out the Office Edition.

Loan Manager

This powerful feature allows you to track, to the penny, all of your loans. It allows you to vary the terms and
interest rates by date range as well as track payments and escrow accounts. Enter the payment amounts and
dates to see the exact impact on interest. You can also split payments to include taxes, insurance, late fees and
penalties. More >>

Amortization Schedules Plus!

With this tool you can see the affect of any number of extra payments at any time and individually override any
payment amount. You can also add lump sum payments starting in any year at almost any interval and
immediately see the effect of different payment frequencies and interest rates on your overall interest costs and
loan retirement time. More >>

Solve for Missing Number Calculator
The Solve for Missing Number calculator allows you to enter your known values and solve for the missing
payment amount, loan amount, interest rate or amortization period. More >>

Payment Grids
Quickly create not just loan payment tables but five different grid configurations allow you to quickly see at a
glance the impact of loan amounts, interest rates and payment amounts. More >>

Financial Calculators
We've included dozens of powerful financial calculators to help you solve most common financial calculations.
More >>

Detailed Reports
Detailed reports are available that will allow you to see on paper varying levels of detail on the loans, schedules
or grids stored in the system. More >>

Just a few more of the key features:

Compatible with US & Canadian mortgages, U.S. Rule (Simple Interest) loans, car loans, business
loans, debt-consolidation loans, student loans and more

Powerful Loan Manager tracks actual loans including the varying terms, interest rates and payments
made and to be made

Easy to use Amortization Schedules include principal and interest breakdowns with running totals of
interest paid and principal remaining

Flexible Planning with Amortization Schedules Plus! Allows you to see the effect of adding, skipping
. or changing any payment. Includes weekly, monthly and annual lump-sum payments starting in
any year

. See the effect of skipping, changing or adding any number of payments

. See the effect of negative amortization

. Handles infrequent and irregular payment amounts

. Calculate a payout amount for the loan as of a specific date using the Loan Manager




Solve for missing number calculator allows you to enter your known values and solve for the
payment amount, loan amount, interest rate or amortization period

. Loan Terms Tracking

. Interest Rate Tracking

Payment Tracking and Projections including insurance/tax/interest escrow plus assess late
fees/penalties

Dynamic Payment Grids including five different grid configurations allowing you to solve for most
missing variables

. Associate a name, address and phone number with your loans

. Dozens of Easy to Use Calculators

. Detailed Reports including annual summaries. Allows you to specify a date range when printing

. Save your grids and schedules for future use

. Create schedules and loans directly from the Solve for Missing Number calculator

. Create loans directly from the Amortization Schedule windows

. Keep notes and track check numbers on individual payments

Fully functienal demo

< Back to Features
Powerful Loan Manager

QuikCalc can be used for tracking and projecting the most complex of loans. Place your loans in QuikCalc to track
to the penny what the status of the loan was, is and will be. You can project forward all of your payments, see
the affect of extra, late, early and missed payments as well as lump sum payments and payment increases. You
can even track insurance, tax and interest escrow accounts and assess late fees or penalties.

View Screen Shot #1 View Screen Shot #2

The Loan Manager allows you to:

Add any number of extra payments including negative amounts that get added to the outstanding
balance (sometimes known as draws)

® | Schedule an annual, monthly or weekly lump-sum on the loan starting in any year

® | Skip or miss payments

e | Record late or early payments

® | Assess late penalties/fees

e | Track Insurance/Tax/Interest Escrow

® | Create loans with different payment types including interest only

® | Use various Day Count Conventions including 30/360 and Actual/Actual

® | Use different compounding methods including U.S. Rule (Simple Interest) and Canadian mortgages

e | Track the actual payment amount and payment date

e | Switch to accelerated payments including bi-weekly and weekly accelerated loans

e | Track varying interest rates by date range

Add your own custom one-time or repeating charges based upon a fixed amount or percentage of a
parameter such as outstanding balance

Calculate loan payout amounts based upon a date you supply then optionally change the schedule to
reflect this payout

® | Record check numbers, payment descriptions and notes on each payment

® | And much more!

Loan Terms Tracking

Track the various terms of your loan over the entire amortization period. You can even project forward different
terms when planning mortgage renewal negotiations. Allows you to change everything about the payment terms
including the day count convention, payment type and compounding type.

View Screen Shot

Interest Rate Tracking

Track the different interest rates by date range. This is particularly useful for variable rate or ARM loans.

Payment Tracking and Projection



QuikCalc will project all of your payments including what portion is principal and what portion is interest. Mark the
payments as paid to track the exact status of your loan or change the projected amounts. Instantly see what
interest rates and terms were in affect for any payment. Quickly see the affect of adding any number of extra
payments, overriding any payment or adding lump sum payments. This module also calculates initial interest
payments at the start of traditional mortgages and balloon payments. You can also track various escrow accounts
and assess late fees and penalties.

View Screen Shot

< Back to Features

Flexible Amortization Schedules

e | Create and save any number of amortization schedules

Allows you to set the loan amount, interest rate, payment frequency (including accelerated
payments) and interest compounding frequency

e | Includes principal/interest breakdowns along with running totals of interest paid and principal owing

e | Change any scheduled payment amount

e | Add any number of extra payments

® | Skip scheduled payments

® | Any payment frequency including monthly, bi-weekly and weekly

e | Allows annual, monthly or weekly lump-sum payments starting in any year

e | Allows you to print your schedule in 5 different formats and specify a date range for the years to print

o | Different compounding methods include U.S. Rule (Simple Interest) and Canadian mortgages

o | Specify a start date for the schedule or use generic time references

Allows any of 14 different Day Count Conventions including 30/360, Actual/Actual, 30/365 and
Actual/360

o | Before and After display shows the effect of the latest changes

e | Undo and Redo buttons allow you to go back and forth through your calculation changes

e | New Compare button allows you to compare the existing schedule with another saved schedule

Create schedules for various different payment types including interest only, fixed principal +
interest, Increment by dollar (Dollar Step) and Increment by Percentage (Percent Step)

e | Handles negative amortization

e | Five different report formats can be printed for different date ranges using specific from and to dates

Annual reports can be summarized based upon any fiscal year end showing interest and principal paid
during the year

e | Create Loan Manager loans based upon your schedule with the click of a button to save time

® | vView Screen Shot

< Back to Features
Solve for Missing Number Calculator

The Solve for Missing Number calculator allows you to enter your known values and solve for the payment
amount, loan amount, interest rate or amortization period. Simply enter what you know and click on the
calculator icon beside the parameter you don't know and QuikCalc will immediately solve for the missing number.
Once finished, you can create a schedule or loan using the calculated parameters with the click of a button.

View Screen Shot

< Back to Features
Dynamic Payment Grids

The Payment Grids tool allows you to generate grids in five different configurations showing payment and loan
amounts based upon various variables along the X and Y axis of the chart. For example, a payment grid with the
loan amount on the left and the interest rate across the top. This tool replaces the old mortgage table books that
are not flexible enough for today's wide array of loan types.

e | Change any parameter and instantly see the results.

e | Five different grid configurations allow you to solve for most missing parameters.

e | Print them out for when you go to the bank or meet with your real estate agent.

Open any number of these windows and compare side-by-side different payment frequencies, interest
rates, compounding, periods and loan amounts.

® | View screen shot

< Back to Features



Dozens of Easy to Use Calculators

We've included dozens of powerful financial calculators that allow you to quickly calculate many common
questions such as Gross Debt Service Ratio and Total Debt Service Ratio that are used to determine what a bank
will lend you. We have also included financial calculators that will allow you do almost any calculation you will
ever need. Some of the calculators we provide:

¢ | Down Payment Amount

® | Gross Debt Service Ratio

e | Gross Debt Service Ratio Maximum Amount

¢ | House Price from Current Rent

® | House Price from Payment Amount

e | Interest Amount

e | Maximum Loan

e | Maximum Payment

e | Mortgage Payment

e | Principal Amount

® | Rent Payments Total

e | Time to Pay Off Accelerated Loan

| Total Debt Service Ratio

e | Total Debt Service Ratio Maximum Amount

e | Total Interest Paid

e | Total Paid for Home

e | Plus many more!

< Back to Features
Detailed Reports

Detailed reports are available that will allow you to see on paper varying levels of detail on the loans, schedules
or grids stored in the system. With most, you can specify a date range to print allowing you to see schedules for
a specific term or period. As well, annual summary reports allow you to summarize based upon any year end you
want, not just the calendar year end. This is especially important for business with corporate year ends other
than December 31. You can also save these reports in HTML format which can then be emailed or included in
other products such as Microsoft Word and Excel. Here are just some of the reports:

o | Payment Coupons

e | Loan Detail Summary Report

e | Loan Detail Payments Report

® | Loan Detail Payments Breakdown Report

® | Loan Detail Annual Summary Report

® | Loan Detail Annual Summary Payments Report

e | Loan Detail Annual Summary with Payment Breakdown Report

e | Loan Detail Payments Report with Notes

e | Loan Detail Payments Breakdown Report with Notes

® | Loan Detail Annual Summary Payments Report with Notes

® | Loan Detail Annual Summary with Payment Breakdown Report with Notes

® | Amortization Schedule - Payments Only Report

e | Amortization Schedule - Payment Breakdown Report

e | Amortization Schedule - Annual Summary

e | Amortization Schedule - Annual Payment Summary

e | Amortization Schedule - Annual Payment Breakdown

e | Payment Grid

® | Plus more!




< Back to Features

What's New in V7.0 Click Here to Collapse

> Try the demo now!

This latest version is the most significant facelift that QuikCalc has ever received and
is receiving rave reviews from our customers.

e New, improved interface!
o New Tab Bar allows one click access to opened windows.

® Plusd of other enh s req ed by our users!

Click here to

Try Now!

Fully functienal demo

Customer Reviews Click Here to Collapse

> Try the demo now!

I just wanted to take a minute and thank you for the hands on support that
your organization provided to Maaco. The application modifications that we
requested were performed with a true willingness to give the customer
exactly what they wanted. I believe that those enhancements will provide
value to your other customers as well. The program application is currently
being used to provide floor planning to three automotive dealerships. I would
be very comfortable being a reference to Slateboard if ever the opportunity
arose.

(V=77
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FUTIERICR'S BODYSHOF™ .
Thanks again,

Neil S. Cooper
Chief Financial Officer
Maaco Enterprises, Inc.

We use your software for our Housing Rehabilitation Program. The program
involves Grants and low-interest Loans. Your QuikCalc Program is the
software that we have chosen to track the financial portion of the program. It
has all the tools we need, and is easy to use.

Slateboard excels at their commitment to their clients. I can’t thank you
enough for the excellent Customer Technical Support that your company
provides. Your support staff has answered every question, walking through
the application step-by-step. Many companies say they provide Customer
Support but fall short of their promise. Slateboard sets the standard for
Customer Service!

I highly recommend Slateboard Software.

Thanks ...

Kathleen Newcomer
Borough of Chambersburg
Housing Rehabilitation

"I wanted to let you folks know that the software is great since the changes you made to address my specific
problems last year. I find that I use it for many different things, and it helps me greatly with my budgeting and
investing decisions. I even found an error my bank made and had it corrected. Sincerely,"

Spring R., Indiana

"I have used it and love it. It allows for 'quirky' payment schemes, i.e. skipping payments, additional principal

payments, etc."

Randy B., CPA, Louisiana

"I looked all over the net and couldn't find anything that did what I needed until I found yours."

Nancy W., Bookkeeper, Indiana

"Used your software today and it is really easy to use and very helpful. Thanks!"

Leatha T., Arizona

"I appreciate the quick response."

Hugh H., British Columbia



"You guys rock!"

Shannon S., Minnesota

"Very helpful”

John E., New Zealand

"Thanks! You guys are awesome. I'm impressed with the support!"

Ed T., Texas

"Love the software."

John E., New Zealand

Click here to

ry Now!

Fully functional demo

< Back to Customer Reviews

System Requirements & FAQs Click Here to Collapse
> Try the demo now!

System Requirements

Computer IBM or Compatible Pentium class PC (Pentium II or higher recommended)

Operating System Windows Vista, XP, Windows 2000, or Windows Server 2003

Memory 256 MB of RAM (512 MB RAM recommended)

Hard Disk Space 45 MB free disk space required

Monitor 1024 x 768 resolution or higher recommended (800 x 600 mode available from Edit menu)

Printer (optional) Required to print reports but not to operate program. Any printer supported by Windows
FAQs

Please click below to find answers to these common questions about purchasing.

If you have additional questions, please contact Customer Service via email at sales@slateboard.com.

How soon will I receive my software?
How long will it take to download?
Can I download again if I need to reinstall my software?

I have additional questions about downloading...
How do I update my data from a prior version of QuikCalc?
How do I get help or technical support?

t

Where can I find
Do you have a money back guarantee?

How soon will I receive my software?

If you order a CD-ROM, you can expect to receive it within 5-7 business days. If you purchase via download, the
product is immediately available to you when the download process is completed. Note that you can also
download when ordering a CD-ROM.

< Back to FAQs

How long will it take to download?

Download times will differ depending on Internet connection speed and other factors. Typically downloads via
"high-speed" connections take 1-3 minutes. Downloads via dial-up are usually much slower and can take 20-40
minutes depending upon the connection speed.

< Back to FAQs

Can I download again if I need to reinstall my software?

Yes. Just visit our Downloads section, select Download My Order and after installing use your registration number
for full access. I you have lost this number, please email sales@slateboard.com with as much information as
possible for us to identify your order and we will send you your code.

< Back to FAQs

I have additional questions about downloading...
For a detailed explanation on how to download, please visit our How to Download Software Over the Internet
page.

< Back to FAQs

How do I update my data from a prior version?

If you install on the same machine as your old version, simply run and register your new software. Once
successfully set up, go to the File Menu and select the Upgrade My X Database menu item where X is the version
number. Only versions you have installed will be displayed. Once selected, your data will be transferred to the
new version.

< Back to FAQs

How do I get help or technical support?
Most questions can be answered by reading the online help or QuikStart guides available from the Help menu in
your software. If your answer cannot be found there, email support is free for as long as you use your software.

Send your question to support@slateboard.com.



< Back to FAQs

Where can I find information or purchase the Canadian version?
All of our software is compatible with Canadian style mortgages and loans. When creating a Canadian mortgage,
simply select a Compounding method of Canadian. Note that all prices on this site are in US$ unless otherwise

noted.

< Back to FAQs

Do you have a money back guarantee?
QuikCalc is quick and easy to learn and is already in use by thousands of individuals and professionals across the
United States and the world. We've been in business for over 10 years and offer a 60 day money back guarantee
on all of our software so there is no risk to you! For more details on our money back guarantee, click here.

< Back to FAQs

Fully functienal demo

Compare Editions

Click Here to Collapse

> Try the demo now!

The feature grid below will help you decide which edition of QuikCalc is right for you. If you still aren't certain, remember that you
can upgrade to any higher edition for the price difference at any time. As well, we have a 60 day money back guarantee on all of

our products.

QuikCalc QuikCalc Pr“e'k u:: QuikCalc
Home Edition Plus! Edition A Office Edition
Edition
Price $39.95 $69.95 $139.95 $299.95
([Futy functional demo available. | HRERIIIN PRI PR PR
zil.tl:hasesecure\yonourweb u“”. NOW IIIH.IY NOW IIIH.IY NOW n‘uv NOW
60-Day
Unconditional
Money-Back v v v v
Guarantee!
Users can share data over a )
network
Multiple simultaneous users v
Track your data by client W
Generate Payment Receipts for v
your clients
Number of Reports available 19 24 24 48
Print Payment Coupons for your
borrowers. v v v v
' e ' '
Includes the Loan Manager 1 Loan Only Up To 5 Loans Unlimited Unlimited
Track multiple interest rates v W W W
[Track multiple loan terms I I W W
Track Interest/Insurance/Tax
escrow accounts. i i v v
Assess late fees or penalties. / ol v \/
Associate names and addresses
with loans v v v v
[Track actual payments made I W v v
Specify different interest and
|payment start dates i i v v
Calculate early payout amounts
and optionally update the W ' ' w
schedule to reflect that change
Add, skip and override
|payments v v v v
|—Dozens of financial calculators W W W
Add any number of extra
{payments i v v v
Put an annual lump-sum
payment on your loan starting v ' ' w
in any year.
See effect of skipping any
number of payments v v v v
Change any payment amount
including your regular payments i v v v
|[Handles negative amortization o v v N
Multiple Day Count Conventions
including 30/360 and ' W W W
Actual/Actual
Multiple Payment Types
including interest only and fixed W vy vy w
principal plus interest.
Allows schedule comparisons. W W W
Solve for missing number
calculator v v v v
Payment Grids v v v v
I




Amortization Schedules

Allows U.S. Rule (Simple
Interest) loans.

Handles accelerated payments
”Hand\es US and Canadian

SOl S |[S
SOl S |[S
SOl S |[S
SOl S |[S

mortgages

Printable reports including

annual summaries v v v v

Save grids and schedules for

future use v v v v
Export reports in HTML v v \/ \/
||Data file backup and restore W W W W

. QuikCalc QuikCalc QM QuikCalc
Further Details P P Premium h .
Home Edition Plus! Edition Edition Office Edition

Still Have a Question?

If you still have a question, please contact us and we will be happy to help you decide what edition is right for
you. Simply email us at sales@slateboard.com and we will respond shortly.

Fully functienal demo

< Back to Compare Editions

Compare the Competition Click Here to Collapse

> Try the demo now!

Ten Reasons Why QuikCalc Beats the Competition!

Flexibility

1 Add, skip or change any payment amount, regardless of what was due. Change the date any
payment was received on and see the impact on interest. Most calculators only allow the

fixed calculated amount and very few allow you to change the dates.

2 Lump Sums
Have weekly, monthly or yearly lump sums, beginning in any year. Most calculators only
allow annual, if any at all.

3 Extra Payments
Have any number of extra payments applied directly to the principal including negative
amounts for balance increases.

4 Payment Types
Unlike most calculators, QuikCalc has 8 different payment types including interest only (fixed
and adjusting), increasing payments (by amount and percentage), and more!

5 Day Count Conventions
Most calculators assume a 30 day month and 360 day year. This may suit some loans but
definitely not all. QuikCalc includes 14 different Day Count Conventions!

6 Interest Compounding

Most calculators only include monthly compounding. QuikCalc includes pretty much any
frequency you can imagine including semi-annual (the most common Canadian mortgage
method), plus Simple Interest (U.S. Rule) where interest is held in escrow if not paid, not
added to the balance like a compounding loan.

7 Interest Escrow

Most calculators don't even include this because they are so inflexible they don't allow you to
change your payments. Changing or skipping a payment where interest is missed is treated
completely differently if you have a Simple Interest (U.S. Rule) loan. QuikCalc automatically
takes care of this for you!

8 Date Based Reports

You can print your schedule with the level of detail you choose and also limit the period
printed by specific date, as well as summarize your report annually based upon a year end
you select (especially important for companies with year-ends other than December 31).

9 Assess Late Fees plus Track Taxes and Insurance
QuikCalc allows you to assess late fees and penalties, service charges plus track tax and
insurance escrow. You can then adjust these account balances and report on them.

10 No Risk!
We have a 60 day money back guarantee! If you are not completely satisfied, you get your
money back. No hassles, no forms, no restocking fees, no risk!




< Back to Compare Competition

Some Facts About Us Click Here to Collapse

> Try the demo now!

Stable
We've been in business since 1994 and have thousands of satisfied clients around the world

. Safe
We offer a 60-day unconditional money-back guarantee so there is no risk to you

. Satisfaction
QuikCalc has an over 99% satisfaction rate based upon number of refunds requested

. Support
We offer unlimited free email support

Try the Fully Functional Demo Now! Click Here to Collapse

Need help making the buying decision? We offer fully functional demos of all of our products. Simply use the links
below to try out QuikCalc before buying. Once installed, use the Try Now button for full access. If you are not
familiar with downloading software from the Internet, click here for detailed step-by-step instructions.

.* Click Here to try QuikCalc (8.5MB)

Fully functienal demo
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